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1 Introduction

For 30 years, Japan Charged-Particle Reaction Data Group (JCPRG) has been accumulating the
nuclear reaction data of charged particles produced in accelerators in Japan as Nuclear Reaction
Data File (NRDF).

Though, recently it becomes possible to obtain experimental data in cooperation with exper-
imentalists, it is necessary to convert the graphical data on the paper into numerical data. In
the past, an input device called "digitizer” was used for reading the numerical data from printed
matters. Recently, the numerical data is read from an image file which is converted from a graph
on a paper.

The software GSYS2.4, described in this paper is used for reading the numerical data from an
image file in JCPRG. Main features of GSYS2.4 is listed below:

e Cross-platform window application which only requires Java Runtime Environment (JRE).
It should work in computers where the JRE are executable (Windows, Linux, FreeBSD, Mac
0OS X, etc.).

e Intuitive and light GUIL.

e Supports PNG, GIF and JPEG image formats.

e Flexible input and output that are compatible with many data formats.
e Feedback function which enables to reuse former data easily.

e Easy set-up of X-axis and Y-axis with automatic axis detection.

e Automatically point recognition: the maker on the figure is automatically recognized and
the position is automatically corrected.

e Magnifying glass function : The glass windows magnify the local area of the figure. You can
performed usual operate on this magnified figure.

This document describes how to use the numerical data reading software, GSYS2.4, [1, 2]
released in Apr., 2010. The contents of this document are shown as follows: Section 2 gives the
basic usage of GS5YS2.4, such as starting-up and reading the numerical data from the graphical data.
Section 3 describes the more sophisticated functions, such as, automatic axis detection function,
feedback function, magnifying glass function and automatic point recognition function. In the
appendix (Section 4), Section 4.1 gives how to customize GSYS2.4. Section 4.2 describes the file
formats treated in GSYS2.4. Keyboard Shortcuts and the changes from last version of GSYS are
written in the section 4.4.

The names of companies and products are the trademarks or registered trademarks of each
company. ® and ™ are not stipulated in this document.

IMPORTANT: PLEASE USE THIS SYSTEM AT YOUR OWN RISK. IT ISNOT ALLOWED
TO USE THIS SYSTEM FOR ANY KIND OF BUSINESS PURPOSE.



2 How to use GSYS2.4

2.1 Installing GSYS2.4

GSYS2 4 requires Java 1.4 or later. Please download and install Java runtime environment from the
website of Java (http://java.com/). Then download an executable file "Gsys2.4.X jar” (X is a version
number) from the website of JCPRG (http://www.jcprg.org/). Now you are ready to start GSYS2.4.
If you want to uninstall GSYS2.4 from your computer, just remove the file "Gsys2.4.X jar”. GSYS2.4
makes a property file “gsys2.properties” in order to save user’s properties. You can also remove
this file if you don’t need it.

2.2 Starting-up the system

Let’s start GSYS2.4 by double-clicking the "Gsys2.4.X jar” file. In case double-click does not work,
type “java -jar Gsys2.4.X.jar” in the directory where Gsys2.4.X jar file exists. When GSYS2.4
starts, you would see the window shown in Figure 1.
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Welcome to GSYS !! Drag and drop your figure file or Start by selecting "Open Image File” from "File” menu

Figure 1: Startup window of GSYS2.4. You can select “Load Image File” in “File” menu. ”Proper-
ties” in ”Edit” menu, and ”Show status bar” in ”View” menu.

The window of GSYS2.4 contains five main components: menu bar, control bar, navigation bar,
main panel, and status bar. Menu bar provides menus to operate GSYS2.4. Control bar contains
functions required to read data, such as setting axes, data points, and error bars. Navigation bar
contains buttons to magnify the Figure, to use magnifying glass function (described in section
3.3). An image loaded from a file is displayed on the main panel. You digitize data on this panel.
In the status bar, a description of a button focused by a mouse, the position of a mouse, and the
coordinates of a selected point are displayed.

GSYS2.4 can be operated using a keyboard, but in this document, how to operate the menu bar
and the control bar by a mouse is explained in detail. Keyboard shortcuts are shown in Table 1 at
Appendix 4.3.


http://java.com/
http://www.jcprg.org/

2.3 Loading the image file

First, you should load the image file. You have the some options to load the image file. The
easiest way to do is by using drag-and-drop. Drag and drop the image file into the main window
of GSYS2.4. If the image file is successfully loaded, the image is displayed on the main panel
as shown in Figure 2. If you can not use the drag-and-drop in your system, select “Load Image
File” from the “File” menu in the menu bar. Select an image file (PNG, GIF, or JPEG) from a
file dialog box in a new window. Or you can specify the image file when you start the GSYS2.4
with command line as “java -jar Gsys2.4.X.jar image-file”. The sample image used in this
document was made from experimental data published in Phys. Rev. 104 (1956) 123, Phys. Rev.
109 (1958) 850, Phys. Rev. 129 (1960) 2252.
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Figure 2: Window after an image loaded. The image is displayed on the main panel and an axis
manager is displayed in a new window.

To enlarge the size of the main panel, expand the window of GS5YS2.4. The main panel expands
and shrinks automatically to fit the size of the window of GSYS2.4. If you want to expand the
main panel more, remove the check from “Show status bar” in the ”"View” menu, and remove the
status bar from the window of GSYS2.4. It is also possible to move the control bar by dragging a
handle (shaded area) at the left of the control bar and navigation bar.

If you want to zoom in and out, select “Zoom in” or “Zoom out” in the “View” menu. Select

"Resize” to recover its original size. You can also zoom in and out by using | Magnify |, | Shrink

buttons on the navigation bar. If you select the button on the navigation bar, Loupe
function (subsection 3.3) will be enabled. This function enables us to enlarge the figure by drag

and drop. You can recover its original size by selecting button.

Note: In order to read-in the data precisely, enlarge the image so that fine tuning of
data points is possible.
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Figure 3: Window after setting positions and value of endpoints of the axes.

2.4 Setting the position and the type of axes

Next, set starting and ending points of X and Y axes respectively. In this subsection, the traditional
method is explained. Another method which use automatic axis detection function is explained
in subsection 3.1.

Press button to enter the X-axis setting mode. button turns red. Click starting and
ending points in order on the image on the main panel to set X-axis. An X-axis with two endpoints
is set on the main panel. Similarly, press button to set Y-axis. Click the starting and ending

point in order. If the starting point of Y-axis is the same as that of X-axis, press button to skip
setting the starting point of Y-axis.

If you want to move starting or ending point of an axis, click the point to move, then move it
by a mouse or cursor keys.

Note: If the X and Y axes are required to be orthogonal to each other, when you move
starting or ending points of an axis, the ending point of the other axis automatically
moves in order to keep its orthogonality. You can change this orthogonality condition
in the property dialog. Detailed description is given in Chapter 4.1.

The axis manager appears in a new window when you load an image in section 2.3. Set
the value of starting and ending points of X and Y axes using ”Start” and "End” menus in the
axis manager. And select the type of the axis from the options (“Linear” and “Log” (Common
Logarithm)) in “Scale” selection box. When you finish setting the axis, you will see a window
shown in Figure 3.



2.5 Reading the data

You are ready to read data if you finish setting the axis. Press button to enter the data input

mode. The button turns red. If you click on the image during the data input mode (When
button is red), a red data point is added on the image. You can add another point by clicking
another place. Continue to click the image until all the data points are added. This mode is
canceled by clicking the button again. When you finish adding the data points, you will see
a window shown in Figure 4.

If you modify or remove the data, please refer to section 2.7 (“Modifying and removing the
data”).

You can configure the shape or tranparency of points, please refer to section 4.1 (Fig. 16 and
Fig 15).
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Figure 4: Window after reading the data points.

2.6 Reading the error information

This section gives how to read error information. First, click a data point which has an error bar on

the graph. The selected data point turns red. To set a symmetric error for X value, press | Xerr(Sy)

button, and click one endpoint of the error bar. To set asymmetric error to X axis, press | Xerr(Asy)
button, and click both endpoints. If you treat a data which has error for only one direction, click

the one endpoint and press | Xerr(Asy) |again.

The same operation can be done for error for Y value of a data.

After setting the error for the first point, the error input button, which is pressed before, turns
pink. This implies that you are still in the error input mode. Select the next point to set a next error
bar. When the point is specified, the button turns red again, and you can set error bar in the same
way as mentioned above. Repeat operations until you finish setting error bars for all the data. To

-7-
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Figure 5: Window after setting error bars.

cancel error input mode, press the error input button again. After inputting errors, you will see a
window shown in Figure 5.

If you modify or remove the error information, please refer to section 2.7 (“Modifying and
removing the data”).

Note: In NRDF data format, an error bar which sticks out from the graph should be
set an “UNKNOWN” flag. First, set errors using ’ Xerr(Asy) ‘ or ’ Yerr(Asy) ‘ When you

treat an NRDF format file, the button is selectable. After pressing the button,
click the endpoint of the error bar. An arrow is displayed at the end of the error bar,

and "UNKNOWN" flag is set for the data. (The output becomes UNKNOWN rather than
numerical value.) Please refer to section 4.2 to know about NRDF format.

2.7 Modifying and removing the data

This section explains how to modify and remove the data.

Modifying the position of data points, error bars, and endpoints of axes

In order to modify a data, select the data point by clicking it. Selected data turns red. Then move
it by a mouse or cursor keys to the correct position. You can modify error bars, and endpoints of
axes in the same way.

Removing data points, error bars, and axes

In order to remove a data point, select the data point to remove. Then press button to remove
it. The data is removed. To remove an error bar, click the endpoint of the error bar to select the

-8-



error bar to remove. The selected endpoint is enclosed by a red circle, then press the button.
To remove an axis, click an endpoint of the axis to select the axis to remove. The selected endpoint

is enclosed by a red circle, then press the button.

Removing all the data points and axis

In order to remove all the data, select “Clear” in the “Edit” menu.

| £ | Clear Dialog @

hat do you want to clear?
[ ¥-axis
[] Y-axis
Data Points

Clear Cancel

Figure 6: Window to select what to clear.

A dialog with check boxes labelled ”X-axis”, ”Y-axis”, “Data Points” is displayed as shown in
Figure 6. Check componets you want to remove, and press button. If you want to cancel
to clear, press button.

2.8 Outputting the numerical data

When you finish reading data, select “Output Numerical Data” from the ”“File” menu. Output
dialog is opened in a new window as shown in Figure 7. This window contains a control panel to
configure output data, and text area in which numerical data is displayed.

First, confirm the information of the axes on the control panel as follows.

e Input the value of starting and ending points of X and Y axes in ”x(start)=", “x(end)=",
"y(start)=", and "y(end)=", respectively.

e Select the type of X and Y axes from “Linear” and "Log” (Common Logarithm) in ”Scale”
selection box.

The default values for the box are the same as the input values of Section 2.4. Please check
the values again here. Besides, set the type of output from the options (“Floating” number and
“Fixed” number), and the number of digit after the decimal point by changing “digit”.

Next, select the output format to use. Please refer to Section 4.2 to know about data format
treated in GSYS2 4.

When you use the Standard Format, set “Error notation”, “Separator”, and ”X-err position” as
follows.

e "Error notation” specifies the settings for error output.

Relative : Output the value of the difference between the value of the data point and the
endpoints of the error bar.
Absolute : Output the value of the endpoints of the error bars.

e ”“Separator” specifies the field separator from the options (comma and white space).

9-



& Qutput Data

Write Save Sort ¥ Sort Y No Sort Close

Ix[start)= o0 |, xendr=[8.0__|, scale: |Linear [+, point: [Fioating |+ |, Digit: [ 3] decimal I

Iv(start)= [200 |, vena)=[180.0 |, Scale: Linear [~ |, Ppoint: [Froating [+ |, Digit: [ 3] tecimal I

I Format of Output Data: I:
L. I: Output Error: I

Control Panel

Text Area

Figure 7: Window for outputting numerical data

e ”X-err position” specifies the position of the error of the X-direction.

"xdxydy” : Output X-error value after the value of X.
"xydxdy” : Output X-error value after the value of Y.

Atlast, select the type of output from the options in ”Output”. “As Read” is selected by default,
and fields are output depending on the presence of the error bars. If you want to omit particular
error, or specify output format, please select from options below.

”No Error” :  Don’t output error.
"X Error” :  Output error for only X-direction.
"Y Error” :  Output error for only Y-direction.

"X &Y Error” : Output error for X and Y direction.

If you finish all the configuration, press button. Numerical data is displayed in text
area.

If you press ’ Sort X ‘ or ’ Sort Y ‘ button, you can sort data in ascending order by X or Y value,
respectively. If you press button, the data is sorted by the order of the data point input.
If you are using NRDF format, or EXFOR format, the data is sorted by X value by default.

Press button to save the output numerical data into a file. Specify file name in the file
dialog in a new window. You can also directly copy & paste to other applications. And Right-click

menu can be available. If you want to close the output window, press Button.

-10-



3 Advanced use of GSYS2.4

Some functions were implemented in GSYS2.4 to read the numerical values more easily and to
improve the quality of the digitized data.

e Setting the axis with automatic axis detection : Section 3.1.

Feedback function : Section 3.2.

Loupe function : Section 3.3.

Magnifying glass function : Section 3.4.

Snapshot function : Section 3.5.

Automatically point recognition function : Section 3.6.

3.1 Setting the axis with automatic axis detection

In the GSYS2.4, there are two ways to set starting and ending points of X and Y axes. The first one
was already explained in subsection 2.4. Another method is setting the axis using the auto axis
detection function, which will be explained in this subsection.

Press button to enter the automatic axis detection mode. button turns red. Enclose
XorY axis by dragging on the image on the main panel as shown in Figure 8. If the automatic axis
detection succeeds, you will see a dialog to choose starting point of the axis as shown in Figure 9.
In the dialog, detected axis is shown as a green line, and detected divisions of the axis are shown
as a blue line. The divisions are given alphabetical names. Choose the appropriate starting point
from the list box on the right, and click @ button. (The label of this button depends on your
system language.) If you want to cancel the automatic axis detection, or think that the detection is
not accurate, click button.

Next, you will see a dialog to choose ending point of the axis. Set as well as the starting point.
You will see then an axis is set.

Note: Automatic axis detection function selects X-axis if the enclosed frame is hori-
zontally oriented, otherwise, it selects Y-axis. If one axis is already set, the other is
set.

The algorithm of the automatic axis detection works properly only if there are only
the axes and the divisions in the frame. If the detection fails, set the frame excluding
extras. If the detection still fails, set the axis with an alternative method explained in
Section 2.4.

3.2 Feedback function

This chapter explains the feedback function. Feedback function is a function to load the numerical
data from files and plot them directly on the image on the main panel. The feedback function
enables us to reuse the data easily and check the data accuracy in greater detail.

In order to use the feedback function, select “Input Numerical Data” from the ”File” menu.
Input window shown in Figure 10 is opened. You can also use this function by drag-and-drop the
numerical data on the figure. This window contains a control panel to configure the settings for
inputting the data, and a text area in which input numerical data are displayed. Or you can specify

11-
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Figure 8: Window to select a starting point of an automatically detected axis.

Starting point

Figure 9: Window to select a starting point of an automatically detected axis.

the image file and numerical data when you start the GSYS2.4 with command line as “java -jar
Gsys2.4.X. jar image-file numerical-file”.

This window contains a control panel to configure the settings for inputting the data, and a
text area in which input numerical data are displayed.

Firstly, select the numerical data to be input, if you did not start this function with drag-and-
drop or command-line option, then press button to open the file dialog and select a file which
you need. Contents of the selected file are displayed in the text area. Instead of selecting a file,
you can input the numerical values into the text area directly, or copy & paste the values (You can
use Right-click menu).

Secondly, confirm that the X and Y axes are set on the image. If not, set the axes as explained in
Section 2.4. If you opened the data which was digitized by GSYS2.X from the same image file, you
can reuse the information of the position of the axis. If axes are not set yet, they are automatically
set by using former information. If axes are already set, they are not automatically set, but you

can set former axes by pressing the | AXIS | button.
Thirdly, input the information of the axes. If you load a file generated by GSYS2.0 and later
version, the information of axes is read from the file header. Confirm the information of the axes.

e Input the values of the starting and ending points for the X and Y axes into ”x(start)=",

-12-
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Figure 10: Window for loading the numerical data file

”x(end)=", "y(start)=", and "y(end)=", respectively.

e Select a type of the X and Y axes from the options, “Linear” and “Log”(Common Logarithm)
in ”Scale” selection box.

Finally, specify the data format. This process depends on a file format. Refer to Chapter 4.2 to
know about file formats treated in GSYS2.4.

e Inthe case of NRDF format or EXFOR format, set ”Sym”(Symmetric Error) or “Asym”(Asymmetric
Error) from ”(X-Error)” and ”(Y-Error)” in “Error” from the options. If the data contains no
error information, select “No Error”.

Note: If you want to use some specific column in the loaded data with NRDF
or EXFOR format, load the numerical data as the standard format as mentioned
below and then revert it back to the original format.

e For the standard format, specify a display format for each column from the options ("X”(X
value), "Y”(Y value), ”X-err”(Error for X), “Y-err”(Error for Y), and “NONE"” (no data or not
to use)).

Only “Relative” error (the difference from the real value) is available for NRDF and EXFOR
formats, but, “Absolute” error (the end of the error bar) is also available for standard format.
Change "“Error notation” if necessary. If you finish all the settings, press button. The data
will be plotted on the image shown in figure 5. To modify the data, follow the explanation in
chapter 2.

13-
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Figure 11: Loupe function. Left figure is how to set the region to be magnified. Right figure is
result of magnifying the igure.

3.3 Loupe function

Using Loupe function, you can magnify the image easily.
Press button, then button will turn to be red. After button turning to

be red, please drag the region to be magnified as shown in the left figure of Fig. 11. The figure will
be magnified as shown in the right figure of Fig. 11.

3.4 Magnifying Glass function

Using magnifying glass function, you can enlarge the figure partially. Click button, and
click on the figure. The glass window will appear. In this window, enlarged figure is displayed as
shown in Figure 12. Usual operation (add point, correct the marker position, and so on, as shown
in Section 2) can also be performed on this glass window.

You can move this window by using dragging. If you put the button again, you can
remove the magnifying glass window.

If you click the window itself, the window is selected. In the case that this window is selected
(edge of window is represented by red), you can move the window by cursor key, or remove the

window by key.

If you would like to use the window after deleting the windows, press button again.

3.5 Snapshot function

In order to use the snapshot function, select button on the navigation bar. Specify file name
in the file dialog in a new “Select File” window.

3.6 Automatically point recognition function

With this function, the maker on the figure is automatically recognized and the position is auto-
matically corrected.

Note: In order to use the automatically point recognition function, please check that
the “Auto Point” is set to be “Yes”. You can check this by checking the “Color & Size”

-14-
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Figure 12: Magnify glass function

tab on the “Properties Dialog” (refer to Section 4.1).

During the data input mode (when button is red as shown), you can add the data point
without strictly pointing the data position. For example, if you click the neighborhood of point as
shown in left hand side of Figure 13, GSYS2.4 recognize and correct the point position, and add
the point.

In the case of the points clowed, this function not always works well. This function is considered
as experimental in this version. The accuracy or precision of recognition will be improved.
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Figure 13: Auto point recognition function. If you click the neibourhood of point as shown in left
hand side, GSYS2.4 recognize and correct the point position, and add the point. If you do not use
this function, data point is added at just the point where you click.

4 Appendix

4.1 How to customize

This section explains how to customize GSYS2.4. Select ”Properties” in the ”Edit” menu. You can
customize GSYS2.4 using the property dialog in a new window. Since the configuration is saved
in a file, "gsys2.properties”, you can also change the configuration by editing that file directory.

Color & Size

When ”Color & Size” tab is selected, you can see the windows shown in Figure 14. You can select
the color of the axes and the data points, the size of the points, transparency of the points or lines
from the dialog boxes. Refer to Fig. 15 about the transparency of points.

Marked data Set the color and transparency of marked data.
Unmarked data | Set the color and transparency of unmarked data.
X, Y-axis Set the color and transparency of axes.
End of X, Y-axis | Set the color and transparency of the starting and ending points of axes.
Size of circle Set the size of data point circles.
Type Set the form of the points. Please refer Fig. 16.
Auto Point Set the automatically points recognition function.
Please refer Section 3.6 for detail.

Error & Axis

When "Error & Axis” tab is selected, you will see the window shown in Figure 17. You can set the
error expression, whether to display the value of the starting and ending points of the axes and
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Color Transparency Sample

Marked data [rep - 50}::‘ -

Unmarked data ‘MAGENTA ‘v‘ | SD)::‘ | ‘

XY-axis |MAGENTA |v| | 0}::‘ -

End of X,Y-axis ‘BLUE ‘v‘ | U}:j -

Points : Size SE Type |CIRCLE :

} Apply || Cancel || Default H Close

Figure 14: Window of the property dialog when the “Color & Size” tab is selected.

Figure 15: Transparency of the points and lines. Left hand side shows the points when transparency
is set to be 0. Right hand side is when transparency is set to be 50.

whether to impose the orthogonality condition for the X and Y axes.

Add vertical bar at the end point of error Set whether to display the vertical line at the
end of the error bar.

Correct the error bar in parallel to the axis Set whether to display the X and Y error
bars parallel to the X and Y axis.

Show error bar at both side (for sym. error) Set whether to display the symmetric error
bars of the data.

Show Axis value Set whether to display the value of the ends
of axes close to the ends of the axes.

Set orthogonality condition to X-axis and Y-axis | Set whether to make X-axis and Y-axis
orthogonal.

@ H A ¢

Figure 16: Form of the points which is selected by Type ( (starting from left) circle, square, triangle,
and diamond).
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Properties

Color & Size || Error & Axis | Format |

Add vertical bar at the end point of error x: '(:
Correct the error bar in parallel to the axis x: '(:
Show error bar at both side {for sym. err.) x: '(:

Show Axis value

Set orthogonality condition to X-axis and Y-axis

X

efon_Tz] vjow [3]

| Apply || Cancel || Default || Close |

Figure 17: Window of the property dialog box when the “Error & Axis” tab is selected.

Format

In order to change the format for the numerical data, select “Format” tab. You will see the window
shown in Figure 18, and you can configure the format used for writing the data and the feedback
function. Refer to section 4.2 to know more about the data formats.

Properties

Color & Size | Error & Axis | Format

x]

Format of Outputinput Data

Qutput format of "Log" scale : Mot fix

Qutput format of “Linear” scale :

| Apply || Cancel || Default || Close |

Figure 18: Window of the property dialog box when the “Format” tab is selected.

Format of Output/Input Data

Set a format of input and output.

Output format of “Log” scale

Set a type of output for “Log” (Common Logarithm) from
floating point number and fixed point number.

Output format of “Linear” scale

Set a type of output for “Linear” from floating point number
and fixed point number

4.2 Data format

There are three formats treated in GSYS2.4. They are used for NRDFE, EXFOR recording, and
general use. They are called NRDF Format, EXFOR Format, and Standard Format, respectively.
Refer to Section 4.1 to learn how to change the format to treat.
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NRDF Format

An example of NRDF Format file is shown below (this example is the data with symmetric error
for X and asymmetric error for Y).

# X +-dx y +dy-dy
1.000E+00 +-2.500E-01 8.000E+00 +4.000E+00-2.500E+00
2.000E+00 +-4.500E-01 4.000E+00 +2.000E+00-NEGLIGIBLE
3.000E+00 +-5.000E-01 2.000E+00 +5.000E-01-UNKNOWN
4.000E+00 +-1.000E-01 1.000E-00 +1.000E-01-1.500E-01

If the data have no error information, '"NEGLIGIBLE’ is output. If the error value is very large so
that the error bar sticks out of the graph, "UNKNOWN’ is output. As for UNKNOWN, it is necessary to set

a type of the error output as unknown by button as explained in Section 2.6. The error
format is +-VALUE (for symmetric error), or + VALUE-VALUE (for asymmetric error). The error
values are given as 'relative’ error (the difference from the real value).

EXFOR Format

An example of EXFOR Format file is shown below.

# X dx y dy -dy
1.000E+00 2.500E-01 8.000E+00 4.000E+00 2.500E+00
2.000E+00 4.500E-01 4.000E+00 2.000E+00
3.000E+00 5.000E-01 2.000E+00 5.000E-01 1.854E+00
4.000E+00 1.000E-01 1.000E-00 1.000E-01 1.500E-01

The columns are separated per 11 characters, and the data with no value is expressed as white
spaces. The error value is given as 'relative’ error (the difference from the real value).

4.3 Keyboard shortcuts

The correspondence between keyboard shortcuts and the buttons on the control bar and menu in
the menu bar is shown in Table 1.

4.4 Changes from GSYS2.2 to GSYS2.4

Following is a list of changes from GSYS2.2. Implementors are shown in parentheses (“Ito” means
Shinya Ito, “Suzuki” means Ryusuke Suzuki).

e Drag-and-drop feature for figure file or file which has numerical values (Ito, Suzuki) : Section
2.3,3.2.

e Transparency of points and lines (Ito), improvement of point figure (Suzuki) : Section 4.1
(Fig. 15).

e Loupe function (Ito) : Section 3.3.

¢ Addition of Point shape (Suzuki) : Section 4.1 (Fig. 16).
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Table 1: Keyboard shortcuts

Correspondence between buttons in control bar and keyboard shortcuts

Operation Button Key
Set X axis. X
Set Y axis. y
Set ending point of Y-axis when starting point is the same as X axis. Y
Set an axis by automatic axis detection. z
Add data points. a
Remove marked data point or axis. D, Delete, BackSpace
Set symmetric error for X direction. F1
Set asymmetric error for X direction. F2
Set symmetric error for Y direction. F3
Set asymmetric error for Y direction. Y err(asy) F4
Set UNKNOWN flag for the error of a data. Unknown u

(Available for NRDF Format.)

Correspondence between menus in menu bar and keyboard shortcuts

Operation Key
Open a window to load an image file. Ctrl + o
Open a window to load a numerical data file. Ctrl + i
Open a window to output data. Ctrl + s
Quit GSYS2. Ctrl + q
Clear data points and axes. Ctrl + ¢
Magnify image. +
Shrink image. -
Recover original size of image. 0
Correspondence between other operations and keyboard shortcuts
Operation Key
Set error bar for X-axis (For the asymmetry error, focus on the error F5
which is set first, then focus on the other error if pressed again).
Set error bar for Y-axis (For the asymmetry error, focus on the error F6
which is set first, then focus on the other error if pressed again).
Focus on the next data point. F7
Focus on the previous data point. F8

e Screenshot function (Suzuki) : Section 3.5.
e Improvement of Auto axis detection function (Ito) : Section 3.1.

e Add Navigation bar (Ito) : Section 2.2 (Fig 1).
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e Magnifying glass function (Suzuki) : Section 3.4.
¢ Add command line option (Suzuki) : Section 2.3, 3.2.

e Automatically point recognition function (Suzuki) : Section 3.6.
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